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LICENSE AND SALES AGREEMENT 
GRANT OF LICENSE 

 
This document is an agreement between you, the end user, and Agency 
Software, Inc.  By initial installation and/or use of any of the programs, 
which are part of Agency Software, Inc. (EasyApps, EasyApps 
Professional, Par3, Par3 for Windows, Agency Underwriter and 
AgencyPro herein after called the progra m), you are agreeing to 
become bound by the terms of all parts of this agreement. This 
agreement constitutes the complete agreement between you and 
Agency Software, Inc., and it may not be changed or terminated orally 
but only by an instrument in writing signed by the party against whom 
enforcement of any waiver, change, modification, extension, discharge 
or termination is sought. 

GRANT OF LICENSE.  In consideration of payment of the License 
Fee, which is a part of the price you paid for this product, Agency 
Software, Inc., as Licenser, grants to you, the Licensee, nonexclusive 
right to use and display this copy of the program at a single location. 

OWNERSHIP OF THE PROGRAM.  As licensee, you own the 
magnetic or other physical media on which the program is originally or 
subsequently recorded or fixed, but Agency Software, Inc. retains title 
and ownership of the program recorded on the original disk copy(ies) 
and all subsequent copies of the program, regardless of the form or 
media in which the original and other copies may exist.  This license is 
not a sale of the original program or any copy. 

USE RESTRICTIONS.  As the Licensee, you may physically transfer 
the program from one computer to another provided that the program is 
used at only one site.   A site is defined as one business at one physical 
location. Branch offices, satellite offices, or multiple businesses sharing 
the same location are not covered under this agreement.  Additional 
licenses for more than one site may be purchased at an additional fee. 

TRANSFER RESTRICTIONS. The program is licensed only to you, 
and may not be transferred to anyone without the prior written consent 
of Agency Software, Inc.  Any authorized transferee of the program 
shall be bound by the terms and conditions of this agreement.  In no 
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event may you transfer, assign, rent, lease, sell or otherwise dispose of 
the program on a temporary or permanent basis. 

Agency Software, Inc.'s entire liability and your exclusive remedy as to 
the disk(s) shall be at Agency Software Inc.'s option, either (a) return of 
the purchase price, or (b) replacement of the disk(s) that do not meet 
the above stated limited warranty and which is returned to Agency 
Software, Inc. with a copy of the receipt.  If a failure of the disk 
returned is from accidental abuse, or misapplication, Agency Software, 
Inc. shall have no responsibility to replace the disk(s) or refund the 
purchase price.  Any replacement disk(s) will be warranted for the 
remainder of the original warranty period or thirty (30) days, whichever 
is longer. 

IN NO EVENT WILL AGENCY SOFTWARE, INC. BE LIABLE 
FOR ANY DAMAGES INCLUDING LOST PROFITS, LOST 
SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL 
DAMAGES RESULTING FROM THE USE OR INABILITY TO 
USE THE PROGRAM, EVEN IF AGENCY SOFTWARE INC. HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR 
FOR ANY CLAIM BY ANY OTHER PARTY. 
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TECHNICAL INFORMATION 
System Requirements 

• Microsoft Word for Windows, version '95 or later, installed 

• Pentium 400 MHz processor (Pentium 500 or faster 
recommended) 

• Windows 98, 2000, NT or XP (ME not recommended) 

• 64 MB RAM 

• 50 MB free hard disk space 

• Microsoft-compatible mouse 

By default, Par3 for Windows is installed in a directory/folder named 
Par32, on the computer's root drive. You can change the name of the 
directory/folder during installation, but not after the program has been 
installed. 

Technical Support 
Technical Support Hotline: 800-342-7327 ext. 30 

For technical support, please have the following items at hand: 

• This user's manual 

• Your Par3 for Windows version number 

Note: Although the Agency Software, Inc. Tech Support department 
will attempt to aid in printer problems and setup, some printing 
conditions may be beyond our control and may require local technical 
help, improved system capabilities, and/or upgrades to your particular 
system or printer.  Additionally, specific questions about Microsoft 
Word should be directed to Microsoft technical support. 
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INTRODUCTION 
Welcome to Par3 for Windows! 
Using Par3 for Windows will save you and your company a great deal 
of time and frustration, present your client with the highest quality 
professional presentation, and MAKE YOU MONEY! 

At this point you're ready to take full advantage of the many powerful 
features of Par3 for Windows. Most features are automated to reduce 
repetition of common tasks, duplication of effort and redundant data. 
Clients and proposals can be added, edited, saved, and duplicated. In a 
proposal, sections can be added, edited, deleted, and re-ordered. In 
short, Par3 for Windows gives you total command of your final 
proposal output with very little effort.  

Par3 for Windows also includes over 200 survey questionnaires 
resulting from our extensive research and interviews with over 200 
types of businesses. 

Familiarity with the features of Microsoft Word will allow you to 
enhance and customize the final product further, but even without 
expertise in Microsoft Word you'll produce excellent, professional 
proposals. 

Features of Par3 for Windows  
The "Par" in Par3 for Windows is an 
abbreviation for "Proposal and Renewal."  
Naturally, the name also connotes imagery of 
golf, and in that context it also implies easy 
success.  

Similarly, Par3 for Windows makes proposal 
writing quick and easy, and integrates 
completely with the EasyApps and AgencyPro programs. If you 
currently use EasyApps or AgencyPro, Par3 for Windows will 
automatically find and use your EasyApps client list. Better yet, the 
single client list will be updated each time you use either Par3 for 
Windows or EasyApps — which means you enter client information 
only once. 

In the Par3 for Windows, you can: 

• Add a new client 

• Update an existing client's record 

• Search for existing clients or client information 

• Delete existing clients and their records 

Par3 for Windows features 
a tabbed interface that 
allows you to easily page 
between the Clients 
Module, the Proposals 
Module, and the Surveys 
Module. 
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• Create a new proposal for an existing client 

• Create or edit a Survey Questionnaire 

• Exit Par3 for Windows  

After a client has been selected, you can click the Proposal button to: 

• Create a new proposal 

• Edit an existing proposal 

• Duplicate an existing proposal 

• Restructure an existing proposal 

• Enter data 

• Delete a client's proposal 

• Customize the Par3 Library to 

• Edit an item in the Library 

• Add a new section to the Library 

• Add a new form to the Library 

• Add new coverage to a section 

• Delete an item from the Library 

• Cancel proposal options 

Client records and proposals can be saved, printed, updated, edited, and 
modified at any time, whether complete or not. 

Each of the features listed above will be covered in detail in later 
chapters in this manual. 

Need Help? 
If you need more help than is available in this 
manual, or if you would like to work with an 
animated tutorial , click the Help button 
(indicated with a red question mark) that is 
found in each module of Par3 for Windows. 
The animated tutorial allows you to see how 
each module works in a step-by-step fashion. 
Where the tutorial isn't available, you will still 
find a full-featured Help application in which you can find your 
answers via the search feature or through a hyperlinked index. 

 
 
Click the Help button  
found within any of the 
modules within Par3 for 
Windows if you are 
stumped or would just like 
more clarity about how 
something works! 
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CHAPTER 1: INSTALLING PAR3 
Important! Microsoft Word for Windows must be correctly 
installed before installing Par3 for Windows. 

 
Par3 for Windows will run on any PC-based computer system that uses 
Windows 95 or later, and has Microsoft Word for Windows (Word '95 
or higher) installed. Installation of Par3 for Windows will add two new 
buttons (P3 and Data Entry) to the Standard toolbar and a new menu 
(Par3) to the menu bar in Microsoft Word. 

Pre-Installation Steps 
If a Par3 for Windows Demo is installed on any computer (standalone, 
on a network server or workstation), the Demo should be uninstalled 
and the Par32 directory (usually "C:\Par32") should be entirely deleted 
prior to installing the actual Par3 for Windows product. 

Standalone Installation 
The most common and preferred way to install Par3 is to install the 
program locally to an individual computer that already has Microsoft 
Word installed on it. 

1. Place the Par3 for Windows CD in the CD-ROM drive of your 
computer. After a few seconds, the following splash screen 
will appear. 

 
Par3 for Windows Splash Screen 
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2. With your mouse or other pointing device, click the text on the 
splash screen that says "Par3 Proposals for Word." 

3. At the "Welcome" screen, click Next . Par3 for Windows will 
search your hard drive to see if it can find a previously 
installed version. 

4. At the "Choose a Destination Location" screen, note where the 
program will be installed (by default this should be 
"C:\Par32"). 

5. If the destination folder is incorrect or unsuitable for your 
system, click on the Browse button. In the text box on the 
following screen, type in the correct path. 

6. Click OK. This will return you to the "Choose a Destination 
Location" screen. Click Next. 

7. The "Select Program Manager Group" screen will appear. It is 
best to go with the default group name, "Par3 Proposals." 
Click Next.  

8. At the "Start Installation" screen, click Next again. 

9. The installation program will then query to see if you already 
have agency information (agency name and contact 
information like address and phone number) stored on your 
computer from a previous installation of another ASI 
application (such as EasyApps or AgencyPro). If you do not 
have any agency information stored, you will be prompted to 
authenticate by providing two passwords. If your ASI 
representative hasn't already provided you with passwords, 
call 1-800-342-7327 and finish the authentication process with 
ASI assistance.  

10. After providing a valid entry password, you will be presented 
with the following "Agency Information Setup" form. Fill out 
the form carefully and click OK.  You will be prompted to 
carefully review your agency information on the form. Review 
the form and make any corrections that are necessary, and then 
click OK again. 

11. You will see a dialog that asks you to "read back" a particular 
number. You will need to provide that number to the ASI 
representative in order for the representative to provide a valid 
exit passwor d. Once you are given the exit password, type it 
into the "Enter Password to Finish" dialog and click OK. You 
should see an "Information Successfully Changed" dialog. 
Click OK again.  
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12. The installation program will then ask to search your computer 
for copies of Microsoft Word. Click OK.  If there is more than 
one installation of Microsoft Word on your computer, you will 
be asked to select which one you would like to have Par3 
attached to. If you are presented with this choice, select the 
appropriate Word installation, and then click OK. 

13. After finding Microsoft Word, the installation program will 
ask to allow it to search for valid ASI products (such as 
EasyApps or AgencyPro). Click OK. If other ASI programs 
are found, you will be asked to select which one is to be the 
"host" program. If you are in doubt, you can right-click on the 
icon of the host program (or what you believe should bet the 
host program) on your desktop or program group and select 
Properties in order to see the path of the program. Then select 
the path in the dialog that matches the path that you just saw 
by viewing the icon properties. Click OK again after selecting 
the host program. 

14. The installation will begin. You will see a screen similar to the 
one below. Please wait while the program installs the files 
needed. 

 
Installation Screen 

15. After the installation has completed, a box of Par3 Proposals 
icons will open. This box can be closed at any time. A Par3 for 
Windows icon will also be installed on the desktop. 
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Par3 for Windows Program Icons 

 

Network Installation 
(Windows XP/2000/NT/98, Peer-to-Peer or Novell) 

Dedicated Server 

This is the preferred server condition. The other network installation 
type is Non-Dedicated on a peer-to-peer network where someone sits 
and works at the server. Just like the standalone installation, Microsoft 
Word should be installed on every machine using Par3 for Windows! 

1. Place the Par3 for Windows CD in the CD-ROM drive of the 
server. 

2. After a few seconds, a screen will appear presenting options to 
install Par3 for Windows. At this time, click the text that says 
"Par3 Proposals for Word." 

3. At the "Welcome" screen, click the Next button. 

4. At the "Destination Folder" screen, make sure that the 
destination folder is pointing to the network drive, e.g., 
"F:\Par32" (assuming that "F" is the network drive).  If the 
destination folder is not pointing to the network drive click on 
the Browse . . . button. This takes you to a screen with three 
boxes. Click on the down arrow button to the right of the 
bottom box, scroll down this list until your network drive 
letter appears, then click on your network drive letter.  This 
should change the path in the top box to your network drive 
path, e.g., "F:\Par32" (assuming that "F" is the network drive). 
Click the OK button. If the Par32 folder already exists 
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(perhaps from a demo installation), you may be warned that 
the directory already exists. Click Yes to install to that 
directory anyway; this will take you back to the "Destination 
Folder" screen. Click OK.  

5. Click Next again. The program will begin installing. 

6. If this is the first time you have installed Par3 for Windows, 
you will need to call your sales representative at (800) 342-
7327 to obtain a password to set up your agency information. 

7. You must now setup all of your workstations using the Setting 
Up the Workstations section later in this chapter. 

8. Also see the BDE Settings section in this chapter to ensure 
that the database engine is working properly at each 
workstation. 

Non-Dedicated Server  
A non-dedicated server is one in which a server also serves as a 
workstation (i.e., a person sits at the server and works on it directly 
while it also performs server functions for other workstations). This is 
not the recommended setup for Par3 for Windows and should only be 
configured with the help of technical support. A non-dedicated server 
must be configured before you install Par3 for Windows. 

Note: Windows 95, 98 and ME can be set up as servers using the 
Dedicated Server instructions described in the previous section. 

Non-Dedicated Server Windows NT/2000/XP: 
NOTE: This configuration should only be needed if Par3 is NOT being 
installed to the default directory, but is instead being installed to a sub 
directory e.g., "C:\apps\Par32" and the "C:\apps" folder has been 
mapped as a drive letter. If Par3 for Windows is going to be used at the 
default directory, refer to the directions for setting up a dedicated 
server.  

1. On your computer desktop, click with the right mouse button  
on NETWORK NEIGHBORHOOD or MY NETWORK 
PLACES (it will be one or the other depending on which 
version of Windows you are running).  A menu will appear. 

2. Select "Map Network Drive . . ." from the menu. 

3. Scroll down the list in the DRIVE box until you come to the 
network drive letter. (F: assuming the network drive letter 
being used is F:\). 
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4. In the SHARED DIRECTORIES box, select the server. Click 
on the drive of the server on which the Par32 folder resides, or 
will reside after it is installed.  

5. Place a check mark in the box labeled RECONNECT AT 
LOGON, and click the OK button.  

6. Check MY COMPUTER to see if a drive letter matching the 
letter you just added appears in the list. 

7. Follow the installation steps provided under the Dedicated 
Server section using the newly mapped drive letter as the 
destination folder. 

Setting up the Workstations 
First, the server PATH must be the same at EVERY computer from 
which you intend to run Par3 for Windows.  This means that the PATH 
must point to the same logical directory on the network even if the 
drive mappings are different at the various workstations. To check this, 
you must go around to each workstation (not the server) and perform 
the following procedure: 

1. Close all open programs at the workstation. 

2. Double click on the "My Computer" Icon on the desktop. 

3. Double click on the logical drive letter that you assume is the 
server drive (e.g., "F").  It should point to the root (not a 
directory/folder) of a physical drive on the server (e.g., "C:\"). 
Look in the lower left hand corner of the window.  The 
number of objects should be the same at each computer you 
check (i.e., if it says "112 objects" at the first station, it should 
say "112 objects" at all of the workstations).   If the numbers 
of objects are not the same between workstations, they are 
probably pointing to the wrong computer as the server.  

4. Close the two open windows by clicking the Close button (the 
one with an "X") in the upper-right corner of the screen.        

5. If the drive letter of the intended server is different at some 
workstations, or if a drive letter is not mapped to the server at 
all, click Start > Help, click the Index tab, and type, "MAP."  
A help index for "Mapping Drive Letters" (or something 
similar) will appear.  Click the Display button.  Then review 
each of the three items listed about mapping network drives 
and review the directions.  

6. Repeat this process until each workstation points to the 
Server's physical drive with the SAME drive letter.  
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Workstation Install 

1. Click Start > Run. In the Run dialog, type 
"F:\Par32\Setupws.exe" (assuming "F" is the network drive 
letter).   

2. Click on the OK button.  When complete, you will have a 
Par3 for Proposals program group created on your Start > 
Programs  menu.   

3. Close the icon group with the close button (the one in the 
upper-right-hand corner with an "X") then close "My 
Computer" to return to the desktop.  A shortcut icon for Par3 
has been placed on your desktop.   

4. If you are prompted to restart your computer, do so.   

5. You are now ready to run the program from the workstation 
by clicking on the Par3 for Windows icon.  

BDE Settings: 
As outlined in the installation instructions, the Par3 for Windows must 
be installed at each workstation with the destination folder pointing to 
your network drive.  After installation at each workstation, the Borland 
Database Engine (BDE) must be configured as follows at each 
workstation: 

1. Click Start  > Programs > Par3 Proposals > BDE Config. 

2. Click on the Databases  tab, click on the plus sign to the left of 
Databases (in the expandable tree below the tabs) to see the 
aliases listed below Databases. 

3. One at a time, highlight the aliases that start "Par3" (e.g., 
Par3Client or Par3Forms) and on the right of each make sure 
the value of the PATH field matches the appropriate network 
mapping. Example: "F:\Par32\DATA" with "F" being the 
network drive. 

4. Click on the Configuration  tab, click the plus sign to the left 
of Configuration, click the plus sign to the left of Drivers , 
click the plus sign to the left of Native  and highlight 
PARADOX.  On the right, the NET DIR line should read 
"F:\PAR32\DATA" (all caps) with "F" being the network 
drive. Don't change the NET DIR line if it has been assigned 
and is being used by another ASI program like EasyApps or 
AgencyPro. What is vital is that every computer accessing the 
BDE needs to point to the same logical path on the network. 
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Note:  After making any changes, leave the field you were making the 
change in before closing the window or going to another tab.  As you 
close the BDE window you may see a dialog that asks if you want to 
save your changes. Click Yes. 

These settings must be made at each workstation on the network where 
Par3 for Windows will be used. 

Updating Par3 for Windows from the Internet 
1. Get all users out of Par3 for Windows including any network 

workstations. 

2. Connect to your Internet provider (providing you don't have 
an "always on" Internet connection). 

3. Click on Start > Programs > Par3 Proposals , and then select 
Update Manager from the Par3 Program menu. 

 

 
 

4. On the "Check for Updates to Par3" screen, clic k Next. 
 

 
 

5. At the "Start Update" screen, click Next . 
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6. At the "Download Complete" screen, click Finish. 
7. At the "Welcome" screen, click Next . 

 

 
 

8. At the "Destination Folder" screen, make sure that the 
Destination Folder is pointing to the correct drive, e.g., 
"C:\Par32" or "F:\Par32" (the first case assuming a standalone 
installation and the latter assuming a network installation).  If 
the destination folder is not pointing to the correct drive click 
on the Browse button. This takes you to a screen with three 
boxes. Click on the down arrow to the right of the bottom 
box, scroll down this list until your drive letter appears then 
click on your network drive letter.  This should change the 
path in the top box to your network drive path, e.g., "F:\Par32" 
(assuming that "F" is the network drive).  Click the OK 
button. You may be warned that the directory already exists if 
the Par32 folder is already there. Click Yes to install to that 
directory anyway; this will take you back to the "Destination 
Folder" screen. Click Next .  

9. On the following screen click Next again. The program will 
prompt you for a password. Enter the password you received 
by calling our automated password system (800-342-7327, 
selection #2) or that you received from the staff at Agency 
Software, then click OK. 

10. If your password is correct, Par3 for Windows will begin 
downloading into the folder you specified in Step 8. 
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CHAPTER 2: STARTING AND EXITING PAR3 
Par3 for Windows is an "add-on" program for Microsoft Word, which 
means it runs within Word and simply adds features to Word that allow 
you to write custom proposals easily. 

To Start Par3 for Windows: 
1. Start Microsoft Word.  

Word opens with two new buttons (P3 
and Data Entry) on the Standard toolbar, 
and a new menu (Par3) on the menu bar. 

2. On the toolbar, click the P3 button. 

Or, on the menu bar, you can select Par3 
> Start Par3. 

The Par3 for Windows dialog box opens (shown below), and 
any open Word documents are saved and closed. 

Par3 for Windows running within Microsoft Word 

 

 
Par3 for Windows 
adds two buttons to 
your Microsoft Word 
toolbar (Par3 on the 
left, Data Entry on the 
right) 
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To Exit Par3 for Windows: 

On the Par3 for Windows dialog box, click the Close Window button  
(the button with an "X" on the upper-right corner). The Par3 for 
Windows dialog box closes, and Word remains open. 

If you are reviewing a proposal draft, the Par3 for Windows dialog box 
will be closed and you'll be working in Word. To exit the proposal, 
save and close the document. You'll need to start Par3 again to work on 
another proposal. 

Note: In later versions of Microsoft Word for Windows (Word 2000 
and greater) you will be asked "Do you want to save the changes to 
P3W.DOT?" upon exit. Click Yes  and then choose to Overwrite the 
file when prompted. 
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CHAPTER 3: CLIENT INFORMATION 
This chapter shows you how to work with the Clients Module (also 
referred to as the client database). If you have EasyApps software 
installed, Par3 for Windows works with your existing EasyApps client 
database. If you don't already use EasyApps, Par3 for Windows will 
create its own client database. 

To access the Clients Module, click the Clients tab. By default, the 
Clients Module is the first screen to appear when you first launch Par3 
for Windows.  

 
 

The Client Module Screen 

Adding New Clients 
A client may be added at any time by clicking on 
the + button on the client module toolbar. This 
will cause the client module to go into add mode.  
The client information fields (the client record 
fields for entering client data like "Client Name", 
"Home Phone", etc.) to the left of the screen will 
become blank in order that a new client's 
information can be typed into the appropriate 
fields.  You must either use the [Tab] key to move 
between fields or move your mouse cursor and click in the desired 

 
The +button on the 
client module toolbar 
places Par3 for 
Windows in add mode 
for entering new client 
information. The √  
button saves the new 
client information.  
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field.  After all of the client's information has been entered, click on the 
√ button once to save the information. 

Note: Clicking the + button or clicking the Post Edit 
button (the √ button) twice to save information could 
result in undesirable effects like losing client 

information or multiple entry of a single client!  

Editing Client Information 
Client information may be edited at any time by 
clicking on a client's name in the Client List on the 
right, and then clicking on the Edit Record button 
(the ?  button).  This causes the client module to 
go into edit mode. The selected client's 
information appears on the left with the Client 
Name  field highlighted, with the cursor in place. 
Begin editing the data, using the [TAB] key to 
move between fields. Save the changes by clicking 
on the Post Edit button (indicated with a √) once. 

Deleting a Client 
You can delete a client by clicking on the client 
you wish to delete in the blue Client List box on 
the right and then click on the Delete Client 
button  (The selected client's information will 
appear in the client record fields on the left). The 
client will be removed from the list after the 
Delete Client button is clicked. A dialog will 
appear asking you to confirm the deletion. 

The Clients Module Toolbar 
In addition to the functions of adding clients, editing clients and 
deleting clients, the Clients Module provides tools for navigating and 
searching the Client List. These tools can all be found in the Clients 
Module Toolbar (see the following picture): 

 

 
The ? button, also 
known as the Edit 
Record button,  on the 
client module toolbar 
places Par3 for 
Windows in edit mode 
after a client is 
selected from the 
client list. Just as it 
does when adding a 
new client, the Post 
Edit button (indicated 
with a √) saves the 
changes. 

 
The Delete Client 
button on the client 
module toolbar 
deletes the current 
record.  



23 

 
 

The Client Module Tool Bar 
 

 The Client Module Toolbar (from left to right):  

1. First Record – Click to go to the top of the Client List. 

2. Previous Record – Click to go back one record. 

3. Next Record – Click to move forward one record. 

4. Last Record – Click to go to the bottom of the Client List. 

5. Insert Record – Click to clear all fields on the left and add a 
new client.  Fill out all of the fields that you can, and then 
click the Post Edit (Check Mark button) to save the record.  
The client name will then appear on the client list. 

6. Delete Record – Select the client you want to delete from the 
list on the right, and then click this button to delete the client.  
All entries in all modules for that client will be deleted from 
your system.  A confirmation box will appear before the client 
can actually be deleted. 
 

Deleted clients and their documents cannot be 
recovered. Be sure you won't need a particular client 
record before deleting it, or else copy their proposals 
onto a floppy disk for archival storage before you 

delete. Procedures for copying a proposal to a floppy disk are in 
the section relating to Floppy Disk Storage. EasyApps also shares 
the Client List with Par3, so deleting a client from either program 
deletes the client from both. Make sure that this is what you want 
to do before proceeding! 
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7. Restore Client List – Returns every client in your client 
database (Client List). 

8. Edit Record – Select the client that you want to edit from the 
list on the right, and then click this button to edit the fields on 
the left.  When done, click the Post Edit button to save the 
changes. 

9. Search Database – Click the magnifying glass to search and 
filter the client list.  All fields on the left will be cleared and 
the cursor will default to the Client Name field.  At this time, 
you may enter search criteria in any or all fields.  Type in your 
search criteria (search phrase), and then click the Search 
Client List button again. The Client List will be filtered to 
show only those clients who match your search criteria.  Any 
customer reports run with the client list filtered would only 
show the information for the filter list.  The top bar of the 
window shows the client list is filtered.  Click the bulleted list 
icon to restore the client list. 

Note: Keep in mind that you can also do a "simple search" by clicking 
within the Client List and then typing the name that you are searching 
for. For example, if you are searching for "Fred Jones Bakery" and you 
have hundreds of clients before the "F" clients, you can click within the 
top of the Client List and then type "Fre" and that should take you 
there. Of course, if you have more than one "Fred" in the list, you will 
have to type more characters for your search string (e.g., "Fred Jo," 
which will differentiate Fred Jones Bakery from the hypothetical "Fred 
James Construction"). 

10. Sorting Client List – Clicking on the title bar of any column 
on the client list will sort the client list by that column. Using 
the scroll bar beneath the blue client list and scrolling right can 
access other columns.   

11. Restore Client List – Restore to full client list after search. 

12. Start Tutorial - This button will start the Tutorial or it will 
bring up the Help Module if the Tutorial is unavailable. 

 
Data Entry Hints 
When inserting (adding clients) or editing existing records, click in the 
appropriate field (except in drop-down menus, see first bullet below) 
to place the blinking insertion point there, then type the appropriate 
information. Alternatively, you may also use the [Tab] key to 
successively move from field to field.  The following tips will also 
prove beneficial for data entry: 
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• Use the drop-down menus where they are available. Note 
that there are drop-down menus in the Type , City, State, and 
Zip fields, as well as under the Assigned Producer, Assigned 
CSR and Status  fields. This will prevent unnecessary data 
entry (you can select from the drop-down menu rather than 
type), prevents typing errors, and keeps your data consistent 
(you won't have a mixed-case entry for a particular city name 
and then another entry with all uppercase letters for the same 
city). Keep in mind, however, that the menu selections for a 
drop-down will only be available after they have been entered 
once. So although you will have to type in the city name for 
"Minneapolis" once, for example, you will be able to select it 
from the City drop-down menu for successive clients from 
Minneapolis. 

• The [Backspace] and [Delete] keys erase characters. 
• To replace an entire word, double click the word to select it, 

then type the new word. 
• The [Left] and [Right] arrow keys move the insertion point 

without erasing characters. 
• You can press the [Tab]  key to move to the next field. 
• You can press [Shift]+[Tab] (press the [Shift] and [Tab] keys 

simultaneously) to return to a previous field. 
• You can enter data in any field, in any order, by clicking in a 

field to place the insertion point there. 
• You can skip any fields for which you don't have information 

except the Name field. 
• Again, use the √ button (Post Edit button) to save the client 

information when you are finished inserting or editing. 
 

Note: The Name field is case-sensitive. If you enter a 
client's name in lower case (fred jones) and again in 
proper case (Fred Jones), Par3 treats the names as two 
separate clients. 

Also Note: Remember to use the drop-down menus  
where they are available. In addition to providing the 
conveniences provided above (see the first bullet), the 
lack of multiple entries for one value (such as a City 

name) will keep your drop-down menu serviceable and 
uncluttered. Imagine a menu with multiple values for one entry: 
Minneapolis, MINNEAPOLIS, MiNNeapolis, etc. 
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CHAPTER 4: PROPOSALS MODULE 
The Proposals Module—the heart and soul of Par3 for Windows—is 
the module that truly integrates the Client Module with the word 
processing and output capability of Microsoft Word. Automation 
occurs through the Proposals Module—client and agency information 
is automatically merged into the Par3 proposals with minimal effort on 
your part. New proposals can be created within the Proposals Module, 
or you can modify the 22 sample proposals and the 330+ coverage 
definitions and forms included with Par3 for Windows. 

Creating a New Proposal 
Before we proceed, it is important to note that the particular client 
you are creating a proposal for should be selected in the Client 
Module (see previous chapter). This is the only way to inform Par3 for 
Windows that you want to provide a proposal for that particular client. 

Note that the current client can be found in the left-hand bottom corner 
of every Par3 for Windows screen. If the client you wish to create a 
proposal for doesn't appear there, you will need to return to the Client 
Module and select the appropriate client.  

I. Enter the Proposal Wizard 

1. Click the Proposals Tab:  After you have your client selected, 
click the Proposals Tab to move to the Proposals Module.  

 
 

The Proposals Module Screen 
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2. In the Proposal Options section of the Proposals Module 
Screen, click the radio button next to "Create New 
Proposal." A black dot will appear in the radio button circle 
indicating that it is selected. Click the vDo It button at the 
bottom of the screen to commit the action. 

3. A dialog will appear requesting that you "Enter a description 
for this proposal." Write a name in the text field that describes 
your proposal and click Next. The Proposal Wizard Screen 
will appear. 

II. Select Sections and Coverages 

The Proposal Wizard screen is where 
you can review and select pre-made 
sections and coverages to include in your 
proposal. In general, sections that have 
coverages under them are listed with the 
word "Explained" in the section title. The 
procedure is to move sections you want 
from the Par3 Proposal Library (on the 
left) to the new proposal (on the right) 
and to order them the way you want them 
to appear in the proposal.  

 
The Proposal  Wizard: Select sections from the Par3 Proposal Library and use the Copy 
button to bring it into your proposal window (on the right). You can use the Remove button 
to take out sections that you later decide are inappropriate. The Review button opens the 
selected section in a new Microsoft Word window, allowing you to review the content. 

Sections and 
Coverages Defined 
The Par3 Proposal Library 
lists countrywide ISO 
sections . Sections can be 
thought of as lines of 
business (e.g., Business 
Auto, General Liability, et c.) 
and may contain 
coverages . A coverage 
(e.g., Collision, 
Comprehensive, etc.) is a 
component of a section, 
and is typically a one-
paragraph description.  
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1. Move the desired sections and coverages to the new proposal 
window by first selecting the sections/coverages and then 
doing one of the following: Clicking the Copy button, 
pressing the [Enter] key, or double clicking the item in the 
Proposal Library. If you are unsure about a section, highlight 
the section in question and click the Review button to open the 
section in a new Microsoft Word window. After reviewing, 
close the Microsoft Word window that contains the reviewed 
section or coverage and return to the Proposal Wizard. 

Alternatively, you can also drag-and-drop the coverages and 
sections into the new proposal window. 

Caution: When reviewing Proposal Library items, 
don't modify items in curly brackets, like 
{.Clnt_Name}.  These items, called tags, are fields that 
will be filled in and replaced automatically when you 

perform the Data Entry procedures later. If you alter them in any 
way, Par3 will not recognize them and Data Entry won't work 
properly. 

 

 

Selecting and Reordering Library Items: You can select multiple sections and coverages 
from the Par3 Proposal Library for inclusion in the new proposal. Holding down the [Ctrl] key 
while clicking on multiple section/coverages allows you to perform a multiple selection. The 
sections/coverages can also be reordered using the up-arrow button (to promote an item) 
and the down-arrow button (to demote an item) 
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2. Order the sections appropriately using the up-arrow button to 
promote a section and the down-arrow button to demote a 
section. 

3. To delete a section or coverage from the new proposal, click 
to highlight that item in the new proposal list, and then click 
the Remove button.  You can also drag the items to the 
Remove button. 

4. When you're satisfied with your new proposal list, click Next. 

Note: You may be asked "Import Integrated Data 
from EasyApps?" If you have EasyApps installed, 
Par3 will check it for client-specific data (like Name 
and Address) to include in this proposal — click Yes 

in the message box to include EasyApps data in the rough draft. 

 

5. The compilation of the proposal will now take place. Don't be 
alarmed if you see strange things happening on your screen — 
blinking screen, disappearing text — because Par3 is simply 
building your proposal in Word.  Do not touch the keyboard 
during the compiling process, as you may interrupt the 
proposal creation of the proposal.  When Par3 is finished, the 
rough draft of your new proposal will be displayed in Word 
and the Par3 for Windows dialog box will be gone. You will 
now need to review the rough draft and edit the draft for any 
necessary changes. 

Proposal Building Tips 

• The Par3 Proposal Library is letter sensitive, which means if you click in 
the list, then type a letter, your selection will jump to that alphabetical point in 
the list. For example, if you want to select a Section that begins with "L," 
click in the Library List, and then type L — the first Section that begins with 
"L" is selected. If there is no entry beginning with the letter you type, your 
selection will not move. 

• You can move up and down the Library List with the [Page Up] and [Page 
Down] keys, with the [Up Arrow] and [Down Arrow] keys, or with the 
scrollbar on the right side of the list. 

• To deselect an item in the list, click it again. 

• You can select and move multiple sections and coverages at one time by 
holding down the [Shift] key and clicking several contiguous 
sections/coverages or by holding down the [Ctrl] key and selecting 
contiguous or non-contiguous sections/coverages individually. 
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• You can also select sections and coverages by moving the focus (the dotted-
line border around an item) up and down the list with the [Up] and [Down] 
arrow keys, and pressing the [Spacebar] to select items you want. 

• You can print out a reference proposal that contains every Section and 
Coverage in the Par3 Library. Click Sample Client in the client list, then 
click the Proposal button; click Edit Existing Proposal, then look for the 
Everything Sample in the proposal list and open it. The Everything Sample 
proposal is about 100 pages long, but a printed copy makes a good desktop 
reference when you are figuring out what to include in a new proposal. 

III. Review and Edit the Rough Draft 

In the rough draft you can edit the wording to suit a particular client or 
company, or to shorten or expand specific schedules. At this point the 
proposal draft is a Word document (as shown below), and you can edit 
it as you would any other Word document. Again, don't mess with 
items in curly brackets, like {.Clnt_Name}, while you are editing the 
rough draft. 

 

Now is a good time to delete extra rows in coverage tables. You can 
also delete extra rows and edit text after Data Entry, during the final 
review.  

Tip: To delete a row, click in the row, then click Table > Delete Row. 
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When you are finished tweaking the draft wording, you can proceed 
with data entry. 

IV. Enter Data and Review the Final Draft 
This is where Par3 uses its tags, the items in the curly brackets, to fill 
in client-specific information in the proposal. 

There are two kinds of curly-bracket items: Par3 tags, which look like 
{.XXX}, and table of contents field markers, which look like { TC }. 
The braces within the tags act as delimiters that tell Par3 for Windows 
to fill in data with the appropriate information—in the case of { TC } it 
fills in table of contents information. 

If you accidentally delete a table of contents field marker, you can 
recreate it this way: 

1. Click at the left end of the table of contents entry, then press 
[Ctrl]+[F9]. A gray field with a pair  of curly brackets and the 
insertion point in between is inserted in your document.  

2. Type TC, and the table of contents field marker is complete. 

If you want to create a Par3 tag of your own, follow these steps: 

1. Click where you want to place the tag, then press [Ctrl]+[F9]. 
A gray field with a pair of curly brackets and the insertion 
point in between is inserted in your document. 

2. Press [Backspace], then press [Delete] (to erase the two spaces 
between the curly brackets). Then type a period (.) followed 
by your field name.  

An example of a tag for an Address field is {.Address}. Data Entry will 
stop at this field and wait for input from you. 

Data Entry  
To start data entry, click the Data Entry button on the toolbar (or click 
Par3 > Data Entry). 
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Par3 scans your proposal, looking for tags. When it finds a tag, it looks 
in the Data Dictionary to see if the tag has a default value (see the 
following "Default Value" section). If Par3 finds a default value for a 
tag, the value is displayed for your approval in the "Value" box on the 
Par3 Data Entry dialog box (shown in the figure below). If there's no 
default value in the Data Dictionary, the Value box is blank. If you've 
imported EasyApps data, more default values will be available. 

The buttons on the Par3 Data Entry dialog box help you enter data as 
follows: 

Accept Accepts the displayed value, and moves ahead to the next 
tag. (Doesn't change entries in the Data Dictionary). 

Save Accepts the displayed value, and saves it in the Data 
Dictionary. (Use this if you change a tag's value and want 
the change made to the default value in the Data 
Dictionary). 

Skip Skips the current tag without entering a value (leaves the 
tag in place so you can supply a value later). 

Back Returns to the previous tag if you want to change the 
value. 

Fast Automatically enters default values in all tags for which 
default values exist. A second data entry session will be 
needed to fill in tags with no default values. 

Cancel Cancels data entry. 

 

If the Value box is blank, or if the data displayed is incorrect, you can 
add or edit the entry in the Value box before you click Accept or Save . 
(You can also edit the information later, in the final draft, as you would 
any other Word document). 

At the Data Entry stage, Par3 goes through your proposal looking for tags and replaces 
them with the appropriate content. You are given the opportunity to Accept the changes, 
Save the document, Skip to the next tag, go Back to the previous tag, or simply choose 
Fast to have Par3 make the default value replacements automatically. 
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Note: Changing the entry in the Value box doesn't change the data 
in the Client List. Items in your Client List, such as address and phone 
number, must be changed in a separate operation (see Chapter 3, 
Updating Client Information). 

Default Value 
A default value is any tag value that's been saved in the Data 
Dictionary; when these tags are encountered during data entry, the 
default value found in the Data Dictionary is filled in.  

If you edit a tag entry, or type an entry for a tag that has no default 
value, you can permanently save the new tag value in the Data 
Dictionary by clicking the Save button instead of the Accept button. 
For example, you might want to save a General Liability limit of 
$1,000,000 as a default value. All proposals from this point forward 
will use this default General Liability limit, until you change it again. 
Keep in mind that another value could be imported if you have another 
ASI product like EasyApps. If so, you will need to correct the 
differences. 

Review the Final Draft 
When data entry is complete, it's a good idea to look over the finished 
proposal before you print it.  

At this point the proposal is a Word document, as shown below, and 
you can make any changes you want using Word's editing and 
formatting tools. 
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The Finished Proposal  in Microsoft Word 

Saving the Proposal 
Par3 documents are automatically saved when you close them, but you 
can save the documents manually at any time by clicking the Save  
button on the toolbar or clicking File > Save . 

Note: Par3 assigns a document name automatically. If you rename a 
proposal, you can later open it in Word (using File > Open) to continue 
with data entry or editing, but Par3 won't be able to find the renamed 
proposal. 
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CHAPTER 5: DUPLICATING AN  
EXISTING PROPOSAL 

If you've already done the work of creating a specific type of proposal, 
and you want to create a similar proposal for a different client, there's 
no need to rebuild the proposal from scratch. You can create a duplicate 
of an existing proposal, or one of Par3's sample proposals, and then 
make any adjustments you want for the second client (which is 
considerably less work than re-creating the entire proposal). To 
duplicate an existing proposal for a different client: 

1. Select the client (or add the new client) you want to create a 
new proposal for. 

2. Click the Proposal Tab. The Proposals Module Screen 
appears. 

3. Under Proposal Options, select the "Duplicate Existing 
Proposal" radio button. Click the vDo It button. 

4. The Duplicate Proposal  dialog box appears, listing all 
existing proposals (including the Par3 sample proposals). 
Decide if you wish to duplicate the raw structure of the 
proposal (no data entry), or have the data entry take place by 
checking or un-checking the "Duplicate Structure Only" 
checkbox. Then click the Next button. 

Tip: Samples are grouped together. There are a large number of 
complete sample proposals that you might find useful to duplicate, 
instead of building a new proposal from scratch. The sample proposals 
are each named "whatever Sample," and are grouped together near the 
beginning of the proposal list. They can be found under the "*** 
SAMPLE CLIENT ***" in the Client List. The Sample Client is added 
automatically and cannot be deleted. 

5. A dialog box asks you to provide a description for the new 
proposal — you can accept the default name, or type a 
different name, then click Next. 

6. A dialog will appear informing you that Microsoft Word is 
going to automatically compile your proposal. Click OK.  
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7. Compilation occurs and then you should see a message 
that begins, "Now review your proposal and delete any 
unnecessary tags . . ." Click OK and then delete the 
unnecessary tags.  

 

8. Click the Data Entry button that Par3 installed on the 
Microsoft Word toolbar and commence the data entry 
process (just as in steps III and IV in Chapter 4). 
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CHAPTER 6: RESTRUCTURING AN EXISTING 
PROPOSAL 

You can open an existing proposal and restructure it so that the sections 
and coverages appear in a different order, or add and delete sections 
and coverages. Restructuring a proposal in Par3 is much simpler than 
using Word's Cut, Copy, and Paste commands to change the document. 

To restructure a proposal: 

1. Start Par3 and select the client in the Client List.  

2. Click the Proposal Tab. 

3. Click the "Restructure an Existing Proposal" radio button, 
select the proposal you want to restructure from the list above, 
and click the vDo It button. 

4. The Proposal Wizard appears, showing the current structure of 
selected proposal. Using the methods learned in Chapter 4, 
rebuild the proposal. 

• Move sections or coverages you've selected from the 
Library List to the existing proposal list by clicking the 
Copy button, by pressing the [Enter] key, or by double-
clicking the selection with your mouse.  

• To rearrange the order of the sections and coverages in 
your existing proposal, click an item you want to 
reposition, then click the up-arrow or down-arrow 
buttons (on the left of the existing proposal list) to move 
that item up or down in the list. 

• To delete a section or coverage from the existing 
proposal, click to highlight that item in the new proposal 
list, and then click the Remove button. 

• When you finish restructuring, click the Next button to 
open the proposal in Word and continue with data entry 
and/or editing. 

Note: The restructured proposal will erase any existing data that 
has been entered. 
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CHAPTER 7: PRINTING 
When you've looked over the proposal thoroughly (remember to check 
it in Print Preview, too), you're ready to print. Use Word's normal 
printing procedures to print your proposal: 

To print: Do this: 

One complete copy, 
quickly 

Click the Print button on the Standard 
toolbar. 

More than one copy Click File > Print, then type or select the 
number of copies you want in the Print 
dialog box, in the Number of Copies box. 

Specific pages, or a 
selection 

Click File > Print, then set what you want 
in the Print dialog box, under Page Range. 

 

The speed and quality of printing will depend on various factors, 
including the type of operating system, computer speed, available 
memory, available cache, type of printer, printer driver capabilities, and 
your printer setup within Windows. Occasionally the amount of printer 
memory is another factor. 

Printer Setup 
If you already have a default printer setup in Windows 95 or greater, or 
you normally print to a network printer, no additional setup is 
necessary. You'll be printing from Microsoft Word, and the default 
Windows or network printer is used. 
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CHAPTER 8: REMOVABLE MEDIA STORAGE 
You will want to store your proposals on floppy disks or some other 
removable media (Zip disks, USB storage cards, etc.) for safekeeping 
and for archiving.  

Copying a Proposal to Removable Media 
To copy a proposal to a floppy disk or other removable media, follow 
these steps: 

1. Put a floppy disk in your computer's floppy disk drive. (If 
you are using some other form of removable media, that is 
fine, just follow along). 

2. Click the Clients Tab and select the client whose proposal 
you want to store. 

3. Click the Proposal Tab. 

4. Select each proposal that you would like to store from the 
proposal list. 

5. In the Proposal Options area, select the "Move Selected 
Proposals to Disk" radio button and then click the vDo It  
button. Par3 will try to save to your floppy drive first, but if 
you don't have one, or would rather save to some other 
media, you can select another drive using the Windows 
"Save As" dialog. 

6. The "Save As" dialog box appears (shown below), and you 
need to rename the proposal file. Here you can select the 
drive you would like to save to and name the file with a 
name that you will recognize later. 

 

The Save As dialog box assumes that your A drive is your 
floppy drive; if your floppy drive is B, then replace the A 
with B. 
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The default name *.p3  is a wildcard placeholder — replace 
the * with a name of your choice, but limit the length of the 
name to eight characters. For example, if the proposal is for 
Mom's Bakery, you might name the proposal file 
"momsbkry." In this example, the entry in the Save As 
dialog box would be "A:\momsbkry.p3 ." 

Do not delete or change the .p3 part of the name. 

7. Click OK to save the proposal to the removable media. 
When it is finished saving, a message box appears that 
informs you that your proposal was successfully saved. 

Copying a Proposal from Removable Media Back to 
Your Hard Drive 
Follow these steps to retrieve a proposal you previously stored on a 
floppy disk or some other form of removable media: 

1. Put the removable media (such as a floppy disk) on which you 
stored the proposal file into the appropriate disk drive. 

2. Click the Proposal Tab.  

3. In the Proposal Options area at the bottom of the Proposals 
Module screen, select the "Read Proposal from Disk" radio 
button.  

4. The Open dialog box appears. In the Drives box, select your 
removable media drive. When the path to your disk drive is 
correct, the filenames on the disk are listed on the left. 

5. Select the proposal you want to retrieve, and then click Open. 

6. The proposal file is copied back to your hard drive, and a 
message box tells you when the proposal was successfully 
imported from the disk. 

If the original proposal file exists on your hard drive, the imported 
stored file will copy over the file on your hard drive. If the original 
proposal file and/or client don't exist on your hard drive, the proposal 
file will be imported and the client information will be added to your 
client list. 
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CHAPTER 9: CUSTOMIZING THE PAR3 
PROPOSAL LIBRARY 

Par3 for Windows comes with a full library of typical insurance 
proposal sections and coverages, which can save you quite a bit of 
composing and writing. Most, if not all, of the sections and coverages 
in the library will be useful to you as written, but if you find yourself 
making the same editing change again and again, or if you need to add 
a section or coverage that isn't in the library, it's easy to do. You can 
also add new forms to the library, and you can delete items you never 
use. 

To make changes in the Par3 Library, follow these steps to open the 
Library: 

1. Click the Proposal Tab. 

2. In the Proposal Options area at the bottom of the Proposals 
Module screen, select the Customize P3 Library radio button 
and then click the vDo It button. 

3. In the Customize Par3 Library dialog box, shown below, 
select the appropriate radio button for what you want to do in 
the Library and then click the vDo It button again. 

 

Edit Marked Item 
1. Select the section or coverage you would like to edit from the 

list. 
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2. Select the "Edit Marked Item" radio button and then click vDo 
It. 

3. The template for the item you selected opens in Word.  

4. Make your changes as you would in any Word document, then 
save and close the template. 

Add New Section Header 
Sections, remember, can be thought of as lines of business (e.g., 
Business Auto, General Liability, etc.) and may contain coverages. Use 
the following procedure to add sections as needed: 

1. Select the radio button for "Add New Section Header" and 
then click the vDo It button. 

2. In the Section Name  dialog box, type a name for the new 
section, then click Next.  

 

3. A new section template is created. The name will appear in the 
Par3 Proposal Library list next time you create a proposal. 

4. Type and format your new section as you would any Word 
document, then save and close it. 

Add New Coverage to Section Header 
A coverage (e.g., Collision, Comprehensive, etc.) is a component of a 
section, and is typically a one-paragraph description. Just as you can 
add sections, you can also add new coverages as needed:  

1. Select the radio button for "Add New Coverage to Section 
Header." Click the vDo It button. 

2. In the Par3 Library dialog box, click the Section you want to 
add the Coverage to, then click Done. 

3. Type a new Coverage name, then click Done.  

4. A new coverage template is created. The new coverage name 
will appear, below the section you selected, in the Par3 
Proposal Library list next time you create a proposal. 

5. Type and format your new coverage as you would any Word 
document, then save and close it. 



43 

Add a New Form to the Library 
A form in Par3 for Windows can be thought of as a document template. 
In other words, a form contains the formatting and boilerplate text that 
provide the structure for a given section or coverage. You can add your 
own forms to Par3 by doing the following: 

1. Select the "Add New Form" radio button, and then click the 
vDo It button. 

2. In the "Section Name" dialog box, enter a name for the new 
form and then click Next. 

3. A new form template is created. The name will appear in the 
Par3 Proposal Library list next time you create a proposal. 

4. Type and format your new form by altering and editing the 
tables as you would in any Word document, then save and 
close it. 

Delete an Item from the Library 
1. Select the sections, coverages and forms that you wish to 

delete from the library list. If you wish to delete multiple 
items, you can select multiple sections and coverages by 
pressing the [Shift] key while clicking the items to select 
contiguous (next to one another) items, or by using the [Ctrl] 
key while clicking the items to select individual, non-
contiguous items. 

2. Select the "Delete All Marked Items" radio button. Click the 
vDo It button. 

3. When the "Delete Items?" dialog appears, verify that you want 
to delete the items by clicking Yes. If you believe you have 
selected a section, coverage or form in error, click No.  

Note: If you select a section, all the coverages attached to that section 
will also be deleted. Make sure that you truly want to delete everything 
within the section! 

4. Provided that you clicked Yes in the previous step, the 
selected items should be deleted. These items will no longer 
be available in your Par3 Proposal Library. 
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CHAPTER 10: SURVEYS MODULE 
The Surveys Module is the result of a lot of homework—our 
homework: Agency Software, Inc. surveyed over 200 types of 
businesses and uncovered the major exposures that ACORD forms are 
not likely to find. 

As a result of doing our homework, we have produced and included 
over 200 survey questionnaires. Most of the surveys are 7-10 pages 
long and contain a checklist of items that will certainly reduce your 
errors and omissions (E & O). 

To make things even better, we placed our survey database into an 
easy-to-use interface (see below) that allows you to save modified 
versions of our surveys as needed. You can also print the surveys 
directly from the application. 

 

The user interface to the Surveys Module is extremely intuitive, but 
keep the following points in mind: 

• To view a particular survey so that you can review, print or modify 
the survey, double click the survey you want in the Survey List at 
the bottom of the screen. 

• You can modify a survey by clicking and typing directly into the 
main window after opening a survey by double clicking it in the 
Survey List. 

• You can save  a modified survey by clicking the Save As New 
Survey button. You can later open saved surveys by clicking the 
Open Saved Survey button. 
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• You can print an open survey (one that is viewable in the main 
window) by clicking the Print button. 

• To create a new survey, select and delete the entire contents of the 
current main window, type or paste your survey in the main 
window (from a text editor), and then save the file with the Save 
button. Although you will not see the survey you created in the 
Survey List, you can always open it at any time as long as you note 
where you saved it. 

• You can click on the Survey List's table headers (the areas marked 
"Survey Type" and "SIC" above the list itself to sort the surveys by 
survey type or SIC code, respectively. 

• Make sure you hit the [Insert] key prior to typing in the main 
window and make sure that it is in overwrite mode . If the [Insert] 
key is in insertion mode , you will end up moving the form 
contents around as you type.  
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CHAPTER 11: CONFIGURATION AND 
MAINTENANCE UTILITIES 

When you installed Par3 for Windows, six other programs were also 
installed on your computer: Agency Setup, Backup, 
BDE Config, Keyfix, Restore, and Update 
Manager. The Update Manager was covered in the 
first chapter, but information regarding the other 
utilities follows: 

Agency Setup 
When you create a new proposal, Par3 inserts your agency information 
(agency name, address, telephone, etc.) into the proposal. You entered 
the default information when you installed Par3 for Windows.  

If the Agency information you entered at installation is incorrect or has 
changed, you can change your default Agency information by 
contacting Agency Software at 1-800-342-7327 and a representative 
will help you with the change in Agency information. The call is 
necessary to protect your investment and keep your software license 
safe from piracy. 

Backup 
The Backup Utility does what the name 
implies—it backs up your Par3 data. It is wise to 
back up your Par3 data frequently and on a 
consistent daily basis. Please note that by 
default the Backup Utility saves the backup 
files to the Backup folder in the Par32 folder. It is a good idea to 
periodically back up your data to some form of removable media as 
well. 

To back up your data, do the following: 

1. Click Start > Programs > Par3 Proposals > Backup. A 
dialog will appear asking you to "Click OK to Begin." Click 
OK. 

2. A "Save As" dialog will appear. By default, it will open the 
Backup directory within the Par32 folder. Par3 uses the 
current date to provide a default name for the file. Click the 
Save  button. 

3. Par3 will notify you when the file has been successfully saved. 

If you need to restore your backed up data, you can use the Restore 
Utility, described on the next page. 
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BDE Config 
It is generally a good idea to leave the BDE Config alone unless you 
need to use it to set up workstations on a network (see Chapter 1). If 
your database configuration becomes corrupted, an Agency Software, 
Inc. representative can help you use this tool to re-establish a database 
connection. 

Keyfix 
The Keyfix Utility re -indexes your database — it rebuilds the indexes 
that your Par3 database uses to sort and search for information, and 
generally cleans up and organizes the program.  

Important: Run the Keyfix utility at least once a month. The Par3 
Maintenance file will keep your Par3 program running smoothly and 
quickly. 

To run the Keyfix utility: 

1. Make sure no one on your network is using Par3 — all 
instances of Par3 should be closed. 

2. Click Start > Programs > Par3 Proposals > Keyfix. A 
progress bar will appear as the database indexes are rebuilt. 
You should get a message stating that it is finished. Click OK. 

That's it! Note: The Keyfix program takes longer to run when your 
database gets large and you've done a lot of work in Par3. 

Restore 
The Restore Utility  restores a database using a backup file (usually 
with a ".BAK" extension on the end of the filename). A restore is 
generally a "last ditch effort" that should only be used if your current 
database is corrupted. Furthermore, a restore will only be effective if 
you have a recent backup file (see the section above regarding the 
Backup Utility). 

To restore a backup file, follow these steps: 

1. Click Start > Programs > Par3 Proposals > Restore . The 
following dialog will appear: 
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2. Click OK. Another notification will appear asking "Overwrite 
Current Data. Are You Sure?" If you are sure, click Yes. 

3. An "Open" dialog will appear so that you can select the 
backup file you wish to restore. Select the file, and then click 
Open. 

4. If all went well, a "Databases Restored" dialog will appear and 
you will be asked to run Keyfix. Follow the directions 
presented earlier in this chapter for running Keyfix.  
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PAR3 TROUBLESHOOTING 
1. I installed the Par3 disk but there are no new icons or Par3 menu 

items in Word, or the icons and menu don't match the manual. 

Solution: Try clicking on Tools - then Macro on the Word toolbar.  
Select the P3Setup macro and Run it.  If you have no P3Setup 
macro, you might have multiple copies of MS Word installed on 
your computer.  See if Par3 installed to the other copy. You also 
might try reinstalling from the CD or updating your program via 
the Internet. 

2. My client list or proposal list is out of order, has strange characters, 
or has completely disappeared. 

Solution:  Make sure that all users get out of Par3 for Windows 
(and EasyApps if it is  installed).  Run the "Par3 Maintenance" icon 
in the Agency Software group.  Then run the "Keyfix" program. 

3. Microsoft Word appears to be "locked up" OR I have a Microsoft 
Word icon that is "Flashing" blue and white after I am done in 
Par3 for Windows. 

Solution: Click on the Microsoft Word icon or the body of the text 
with your mouse.  Another open program captured control of your 
computer after Par3 completed its operation. 

 

50 

INDEX 
√ button, 22 
√ key, 22 
+ button, 21 
+ key, 22 
?  key, 22 
Add a New Form. See 

Customizing Proposals 
Add New Coverage. See 

Customizing Proposals 
Add New Section Header. 

See Customizing 
Proposals.  

Agency Setup, 45 
animated tutorial. See 

Help Application 
Backup, 45, 46 
Backup Utility. See Backup 
BDE, 16. See  
Borland Database Engine, 

16 
Client List, 22, 23, 24 
Clients Module, 8, 21, 22 
Clients tab. See Clients 

Module 
Copy button, 28 
Coverages, 27 
Create New Proposal, 27 
Customizing proposals, 40 
Dedicated Server. See 

Network Installation. 
Default Value, 32 

Delete an Item. See 
Customizing Proposals 

Delete Client, 22 
Delete Client button, 22 
Delete Record. See 

Deleting a Client 
Deleting a Client, 22 
DRIVERS, 16 
Edit Marked Item. See 

Customizing Proposals. 
See Customizing 
Proposals 

Edit Record button, 22, 24 
entry password. See 

Installation 
exit password. See 

Installation.  
Final Draft, 31, 33 
floppy disks. See 

Removable Media 
Storage 

Help application, 9 
Help button. See Help 

Application 
Installation, 10, 11, 12, 13 
Keyfix, 45, 46, 47, 48 
NET DIR, 16 
Network Installation, 13 
Non-Dedicated Server. See 

Network Installation 
P3 Button, 19 
PARADOX, 16 
PATH, 15, 16 
Printing, 37 
Proposal, 1, 2, 8, 9, 26, 27, 

28, 29, 30, 33, 34, 36, 38, 
39, 40, 41, 42 

Proposal Library, 28 
Removable Media Storage, 

38 
Remove  button, 29 
Restore, 46 
Restore Client List, 24 
Review button, 27, 28 
Search Database , 24 
Sections, 27 
Sorting Client List, 24 
survey. See Surveys 

Module. Survey, 8, 43, 44 
Surveys Module, 43 
table of contents, 31 
tags, 28, 31, 32, 35 
The Clients Module Tool 

Bar, 22 
Update Manager. See 

Updating Par3 for 



51 

Windows from the 
Internet, 17 

workstation.. See Network 
Installation. 

Zip disks. See Removable 
Media Storage 

 


